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Symbols and Tweens 
Symbols in Flash are used for components that you want to re-use. This saves you a lot of effort and 

also makes your flash files smaller. 

There are three types of symbols available in Flash. 

 Graphic – used for re-using images in an animation 

 Movie-clip – Allows a lot more options than a graphic symbol. Also allows you to have 

animation within a symbol 

 Button – Allows you to create buttons with different looks/animations for button press, mouse 

over etc. 

You can create a symbol by selecting something you have already drawn and then using the convert 

to symbol option. You can also create a new blank symbol and then draw inside it. 

Create a new flash project and save it as Traffic Lights. Remember to save regularly as you are 

working. 

 

Use the shape tools to create a rectangle similar to the following (black stroke with a gradient fill. 

 

Double-click the shape with the selection tool to select both the stroke and fill. There are several 

ways you can convert a selected object in to a symbol. Use one of the 

following methods: 

 From the Modify menu choose Convert to Symbol 

 Right-click the selected object and select Convert to Symbol 

 Press F8 on your keyboard 

 Drag the selected object in to the Library panel as shown to the 

right 

When you create a symbol using one of the above methods, the options below will appear. 
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Enter Lights Back for the Name and change the Type to Graphic if needed 

The new symbol will now appear in the Library panel as shown below. If you select the symbol in 

the library, you will see a preview of what that symbol looks like. 

 

You can add multiple copies of this symbol in your animation. Each one can be in a different size and 

position. Each one can also have different colours and other effects added to it. So they can all be a 

little different without you having to create each one from scratch. 

Double-click the symbol within the library (or use the selection tool to double-click the object on the 

stage). You will now be editing the symbol. At the top of the page you will see the Scene name 

followed by the name of the Symbol. If there was anything else on the stage it will be dimmed while 

you are editing the symbol. Any changes you made here would affect any other copies (instances) of 

the symbol in your animation. 

 

Click on Scene 1 or double-click outside the symbol with the selection tool to exit editing the 

symbol. 

Select your shape on the stage and press [Del] to delete it. The symbol is still in your library so we 

can still add it from there later when we need it. 

Create a shape like the one below (radial gradient fill with no stroke). Remember to hold down 

[Shift] while you draw the oval to make it a perfect circle. 

 

Convert the shape in to a Graphic symbol called Light. 

Delete the light symbol from the stage now that it’s been saved in the library. 

Now we will create a blank symbol and then put the symbols we have already created inside it. 

Click the New Symbol button at the bottom of the Symbols panel. 

 

Call the symbol Traffic Lights and this time set the type to Movie Clip. 

Your stage will look blank since you are now editing a symbol that doesn’t have anything in it. 

Drag your Lights Back symbol to the middle of the symbol editing area (a small cross indicates the 

middle). 

Move your mouse over the layer name in the Layers area and double click to rename the layer. 

Change the layer name to Back. 
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Click the New Layer icon at the bottom of the layers panel to create a new layer. Rename the new 

layer and call it Bottom Light. 

 

Drag the Light symbol on to the stage and position it (resize if needed) near the bottom of the Lights 

Back symbol. 

 

Create a new layer called Middle Light. Place a copy of the Light symbol in the middle. 

Create a new layer called Top Light. Place a copy of the Light symbol in the top. There should now 

be three instances of the Light symbol, each on a different layer. Remember that these layers are 

inside the new Traffic Lights symbol. They are not on the project’s main stage which is still blank. 

 

Checking Layers 

You will notice that the layers panel has dots next to each layer. Symbols above those dots let you 

know what the dots mean. The dots underneath the eye symbol can be clicked to hide and unhide 

layers. Try clicking the dots in the first layer to turn layers on and off. When a layer is hidden, the dot 

on that layer will be replaced by a  symbol which you can click to turn that layer back on. 

 

The second column of dots is for locking layers. If you click the lock dot on a layer, the dot will 

change to a symbol. While a layer is locked you won’t be able to make any changes to that layer. 

This can be useful for preventing accidental changes to a layer while you are working on another part 

of your animation on a different layer. 
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The last column has a colour square next to each layer. When you have a lot of layers it can 

sometimes be difficult to determine which layer each part of your animation is on. Click the outline 

symbol next to the Middle light layer. The contents of that layer will be shown as an outline of the 

same colour as the outline symbol. Click the symbol again to return that layer to its normal view. 

    

A common mistake in Flash is to draw or place objects on the wrong layer. You can always tell 

which layer you are currently editing as it will have a pencil symbol next to it. Anything you draw or 

add from the library will be added to that layer. 

Note: Anything you want to be animated needs to be on its own layer. Since we want each of the 

lights to animate separately from the others, they each need to be on their own layer. The animation 

won’t work otherwise.  

The Timeline 

We are going to animate the lights so that the green light is lit up to start with for 2 seconds. The 

amber light will then be lit for one second. The red light will be lit for 5 seconds. Finally, the green 

light will be lit up again for 2 seconds. Add all of that together and we have a total animation time of 

10 seconds. 

The area next to the layers area is the timeline. On the bottom of the timeline you can see 

. That lets us know that this animation will display at 24 frames per second. We need to 

keep that in mind when we’re deciding how many frames something will need to display before 

changing it. Since our whole animation will be 10 seconds we will need 240 frames. 

Our animation needs to start with the green light lit up so we’ll do that to begin with. Select the 

bottom light as that will be our green light. Show the properties panel. When you have a symbol 

selected, one of the properties will be Color effect. Change the style option to Tint. Click the colour 

box next to the Style and select a green colour. Change the options beneath if needed until your light 

looks like a suitable shade of green. 

    

The traffic lights need to remain like this for 2 seconds so we will use the timeline to create the extra 

frames we need. 
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The lights need to stay the way they are for 2 seconds which will be 48 frames. Click on frame 48 on 

the Back layer. Insert a frame by doing any of the following. 

 From the Insert menu select Timeline and then Frame. 

 Right click on the selected frame and from the shortcut menu select Insert Frame 

 Press F5 on the keyboard. 

When you add a frame, all of the frames until that point will also be filled in. You will also notice 

that the lights are no longer visible. That is because the layers the lights are on currently only have 

one frame so they don’t appear beyond that first frame. We will need to add additional frames for 

those layers. 

 

 

Click on frame 48 for the Top Light layer and add a frame so that the top light also shows for 48 

frames. 

Key Frames 

Any time you want something in your animation to change, you use a key frame instead of a regular 

frame. Key frames mark places on your timeline where you want a change to take place. 

In frame 48 the bottom light will change back to being dark while the middle light will change to 

amber. Because both layers are changing, both layers will need a key frame at frame 48 in the 

timeline. 

Click on frame 48 on the Bottom Light layer. Add a key frame by doing any of the following. 

 From the Insert menu select Timeline and then Keyframe 

 Right click on the selected frame and then from the shortcut menu select Insert Keyframe 

 Press F6 on the keyboard 

A key frame will show on the timeline as a frame with a dot inside it.  You will notice that each 

layer starts with a key frame on frame 1. If you have a frame with a hollow dot,  that means you 

have a key frame on a layer that doesn’t have anything on that layer. This sometimes happens when 

you accidentally drew on the wrong layer. 

Make sure you are still on frame 48 and select the bottom light. Change the colour properties so that 

the light is no longer lit up (hint – change the Tint property to 0) 

Add a key frame on frame 48 of the Middle light layer. 

Select the middle light and change its colour properties to make it an amber colour. 
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Click on frame 1 in the timeline. The bottom light should be the only one lit up and should be green. 

Click on frame 48 in the timeline. The middle light should be amber with the others not lit up. 

We want the traffic lights to show amber for one second so we need to add additional frames. The 

only layer that won’t be changing at all is the back layer so we might as well add all 10 seconds 

worth of frames for that one right now. Click on frame 240 (10 seconds) on the Back layer. Add a 

frame (F5 - not a key frame) at this point so that layer will display unchanged for 10 seconds. 

The next time the lights change, the bottom one will be remaining the same. Click on frame 72 (3 

seconds) and add a frame (F5) for the Bottom Light layer. 

The top 2 lights will both be changing at the 3 second mark so they will both need key frames at 

frame 72. 

Click on frame 72 in the Middle Light layer and add a Key Frame (F6). Select the middle light and 

change its colour properties so that it is no longer lit up. 

Add a Key Frame at frame 72 on the Top Light layer. Select the top light Change the colour 

properties so that it is lit up in red. 

So now at the start of the animation, only the bottom light will be lit up in green. At the 2 second 

mark (48 frames), only the middle light will be lit up in amber. At the 3 second make (72 frames), 

only the top light will be lit up in red. 

We want the lights to stay red for 5 seconds so the next change won’t happen until 120 frames later at 

the 7 second mark (frame 192). 

The middle light won’t change again for the rest of the animation so place a frame (F5) on the last 

frame (frame 240) of the Middle Light layer. 

At frame 192, the red light will switch off so place a key frame (F6) at frame 192 of the Top Light 

layer. Select the top light symbol and change its properties so it is no longer lit up. There are no 

further changes on this layer so add a frame (F5) at frame 240 of the top layer. 

At frame 192, the bottom light will light up green again so place a key frame (F6) at frame 192 on the 

Bottom Light layer. We want the light to be exactly the same shade of green that it was on the first 

frame. One way we can make sure it’s the same is by copying the frame. 

Right-click on frame 1of the Bottom Light layer. Select Copy Frames. 

  

 

Right-click on frame 192 of the Bottom Light layer. Select Paste Frames. This key frame will now 

be exactly the same as the one we just copied with a green light of the same colour. There are no 

further changes on this layer so add a frame (F5) on frame 240 of the Bottom Light layer. 

Remember to save changes to your project. 

Previewing the Animation 

The red marker along the top of the timeline is they Play Head. The position of the play head 

indicates which part of your timeline will display on the stage. You can drag the play head along the 

timeline to see how your stage will look at each point in the timeline. 
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You can also play and preview your animation by doing the following. 

 From the Command menu select Go to End to move to the last frame or press [Shift] [.] 

 From the Command menu select Rewind to go to the first frame or press [Shift] [,] 

 From the Command menu select Play or press [Enter] to play from the current position. 

Hold down Shift and press the comma key to move to frame 1. Press [Enter] to play your animation 

from that position. You should have a green light for 2 seconds. Amber light for 1 second. Red light 

for 5 seconds. Then green light for the last 2 seconds. 

Click the scene name at the top of the stage to exit editing the Traffic Lights movie clip symbol. 

 
You will be returned to your blank stage. We will make use of that Traffic Lights symbol later but 

first we have some other content to create. 

Creating a Car 

So far we have a Traffic Lights movie symbol which contains a symbol for the background, and three 

instances of a light symbol. Now we will create a movie clip symbol of a car, which will contain 2 

instances of a wheel symbol which will have a rotating wheel. In the final animation, our car will 

move across the stage, pull up at the lights when they turn red, and then move again when the lights 

turn green. 

Creating the Wheel 

Create an image of a car wheel using the drawing and shape tools. 

 

Select the whole wheel including the fill and stroke (double-click with the selection tool). Convert to 

a graphic symbol (F8) called Wheel. 

 
 

Now we will create a movie clip symbol which has an instance of this wheel symbol rotating. 
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Delete the wheel from the stage. It will still be in the library. 

Click the New Symbol button  at the bottom of the Library panel. 

Call the new symbol Rotating Wheel and make it a Movie Clip symbol. 

 
 

You will now be editing the new symbol and will have a blank editing area. Drag an instance of the 

Wheel symbol from the library in to the middle of the editing area (use the cross as a guide). 

In the layers, double-click on the layer name to rename it and call the layer wheel. We will animate 

the wheel so that it does a 90º rotation every 5 frames. 

Add a key frame (F6) at frame 5. 

From the Modify menu select Transform and then select Rotate 90º CCW. 

Add a key frame (F6) at frame 10. 

From the Modify menu select Transform and then select Rotate 90º CCW. 

Add a key frame (F6) at frame 15. 

From the Modify menu select Transform and then select Rotate 90º CCW. 

Add a key frame (F6) at frame 20. 

From the Modify menu select Transform and then select Rotate 90º CCW. 

 

Motion Tweens 

Motion tweens allow you to create a transition from one key frame to the next so that flash fills in the 

frames in between (tweening) to create a smooth animation. There are 2 types of motion tweens. 

Regular tweens we will look at later on. For this rotating wheel, we will use the method of animation 

used in older versions of flash. In the current version this method is referred to as a Classic Tween. 

Right-click between the first key frame and the second key frame (between frame 1 and frame 5) 

 
From the shortcut menu select Create Classic Tween. An arrow will appear between the key frames. 

This lets you know that Flash is creating frames between the key frames that will link them together 

in a neat animation. 

Create classic tweens between each of the other key frames so that your timeline looks like the 

example below. 

 
Press Shift comma, to move to the first frame. Press Enter to play the animation. The tweens should 

make it looks like the wheel continues rotating between each of the 90º turns. 

Click Scene 1 to finish editing the rotating Wheel symbol and return to your stage. 
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The Car Symbol 

Click the New Symbol button  at the bottom of the Library panel. 

Call the new symbol Car and make it a movie clip symbol. 

 
Rename the layer and call it Car. 

 
Draw a car without the wheels. 

 

Click the New Layer button  in the layers panel. 

Rename the new layer and call it Wheels. 

Drag the Rotating Wheel symbol (not the wheel symbol – make sure it is the movie clip one that has 

the rotation animation inside it) from the library on to the car. Resize and position it where the rear 

wheel should be. Add a second instance of the wheel so that it is resized and positioned where the 

other wheel should be. 

 
Click on Scene 1 to return to the blank stage. 

 
 

Now to create the rest of our animation. In our main scene there is only one layer. Rename that layer 

as Background. 

  



Using Flash  Traffic Lights 

© Steve O’Neil 2012 Page 10 of 12 http://www.oneil.com.au/pc/ 

Draw some scenery on the background layer including a road and another road crossing it (this is 

where we will put our traffic lights). 

 
 

Create a new layer and rename it Traffic Lights. 

Draw a pole for your traffic lights on one of the corners of the intersection. 

Drag the Traffic Lights movie clip symbol on to your stage. Resize and position it so that it is on top 

of the pole. 

 
You can create more than one if you like by putting another pole and traffic light on one of the other 

corners. 
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Create a new layer and call it Car. 

 
 

Drag the car movie clip symbol from the library on to the stage. Resize it so that it is a suitable size 

for the road you have drawn. 

Move the car off to the right side of the stage in the grey area. Remember that anything outside the 

stage area won’t be visible when you play the animation. We want the car to appear from the side. 

 
 

The Background layer and the Traffic Lights layer won’t be moving during the animation (other than 

the changing lights which is inside the traffic lights symbol). Create a frame at frame 240 for both 

layers (10 seconds). 

Right click on the first frame of the Car layer and select Create Motion Tween. Flash will create one 

second’s worth on animation (24 frames) on that layer – shown as a blue bar. 

 
Drag the end of the animation bar until it reaches 240 frames. 

Click on frame 240 of the Car layer. With the select tool, move the car to a position before the 

intersection so it looks like it’s pulled up at the lights. A dotted line will appear to indicate the path 

the car will be moving along. 

 
 

Drag the dots on the line so that the line follows the road. 

Click on frame 48. This is 2 seconds in, where the lights change from green to amber. Move the car 

to a position shortly before the intersection. A small dot will appear on the timeline. This is a 

property frame and indicates that a change is happening at that point in the tween. 
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Click in frame 72. This is where the lights turn red and the car should come to a stop. At this point 

the car should be at its finishing position – stopped at the intersection. We want it to wait there for 5 

seconds while the light is red before moving off again. Add a key frame (F6) at that point. It will look 

the same as your other property frame. 

 
Add another keyframe 5 seconds (120 frames) later at frame 192. There will be no movement 

between this frame and the last once since the car’s been waiting at a red light. 

Click on the last frame (frame 240). Drag the car off the left side of the stage to set the point it will 

move to in the last part of the tween. 

 

 
 

Testing the Whole Animation 

Go to the start of your timeline (Shift ,) and press Enter to preview your animation. Your animation 

will play through but there are some things you won’t see such as animation within symbols (wheel 

rotating in the car and lights changing colour on the traffic lights). To see the complete animation you 

need to use the Test Movie option. Save changes to your project first. 

From the Control menu select Test Movie and then select Test or press [Ctrl] [Enter]. 

The movie will appear in a floating window and will include all parts of the animation including the 

changing lights and rotating wheel. Of course the wheels will continue rotating while the car is 

stopped at the lights. Stopping and starting animation like that when needed is done with action script 

which is a programming language used within flash. We won’t be getting in to action script in this 

exercise. 

Testing your movie will also create a .swf file in the same location you have saved your project in. 

When you are working with flash and save your project it will be a .fla file. These can only be 

opened in the flash application. A .swf can be viewd in the flash player which is included in web 

browsers and other devices such as phones. So when you test movie, you can send the .swf file to 

other people so they can view your animation or put it in a website for people to view. 


